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1. ¿QUÉ ES MENDELEY? 
 

Mendeley es un gestor bibliográfico que combina una versión web con 

una versión de Escritorio. Además incorpora funcionalidades de la 

Web 2.0 que permiten compartir las referencias bibliográficas con 

contactos y navegar por los contenidos subidos por otros usuarios. 

Mendeley dispondeo de una versión gratuita y otras versiones de 

pago con mayores funcionalidades. 

 

2. ACCESO A MENDELEY Y CREACIÓN DE UNA 

CUENTA 
 

Lo primero que necesitamos para poder usar Mendeley es acceder a 

su página web y crear una cuenta. La dirección de acceso es: 

http://www.mendeley.com 

 

El siguiente paso es crear una cuenta para ello hay que pinchar en el 

enlace “create a new account” y cubrir el formulario 

correspondiente. 

http://www.mendeley.com/
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Si disponemos de cuenta en Facebook también podemos entrar con 

esos datos.  

Una vez creada la cuenta podremos descargarnos la aplicación para 

instalar en nuestro ordenador, desde el enlace Download Mendeley 

Desktop. 

 

Elegiremos la versión correspondiente a nuestro sistema operativo, 

(Mac, Windows y Linux, además incluye una versión para Iphone, 
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para Ipad e Ipod Touch) y lo instalaremos en el ordenador siguiendo 

las instrucciones. Una vez instalado ya podremos trabajar con él.  

Nota: Esta guía se orienta principalmente al uso de Mendeley en 

Windows. 

 

De esta forma tendremos disponibles la versión local (en adelante 

Mendeley Desktop) y la versión web. 
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 Características de Mendeley (2): 

 Mendeley extrae automáticamente los metadatos y las 

referencias de los artículos desde archivos PDF. También 

recupera información adicional desde Crossref, PubMed, ArXiv, 

etc. 

 Permite realizar búsquedas a texto completo en la biblioteca de 

archivos PDF, dispone de un visor propio de documentos PDF 

en el que podemos subrayar el documento y hacer anotaciones 

para compartir con colegas. 

 Permite sincronizar la base de datos bibliográfica a través de 

varios ordenadores, compartir con colegas, administrar online o 

integrar las referencias en blogs y sitios web. 

 Integración con editores de texto como Microsoft Word u 

OpenOffice Writer. 

 Captura referencias bibliográficas de sitios web usando la 

herramienta “Web Importer” para instalar en diferentes 

navegadores o sincronizándose con Citeulike y Zotero. 

 Crear grupos para compartir documentos y etiquetas con 

colegas 

 Ver estadísticas de los documentos, autores y publicaciones, 

además de las estadísticas sobre la biblioteca de nuestra 

cuenta. 

 Permite crear un perfil profesional de investigador para 

compartir las publicaciones, premios y conferencias. 
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3. VERSIÓN LOCAL (MENDELEY DESKTOP) 

 

 

La pantalla en la versión local se estructura de la siguiente manera: 

 My Library. Desde aquí podemos configurar y administrar las 

distintas colecciones de documentos 

 Desde esta sección podemos aplicar filtros por autor, palabras 

clave, publicaciones o etiquetas personales 

 Biblioteca donde se muestran todos los documentos dispone de 

2 tipos de visualización: formato tabla (tal como aparece en la 

imagen) y cita, en el que las referencias aparecen en varias 

líneas de acuerdo con el estilo de cita elegido. 

 Desde este apartado se visualizan los detalles del documento 

seleccionado, también se agregan etiquetas y notas. 
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4. AÑADIR REFERENCIAS 
 

Mendeley dispone de diferentes opciones para añadir referencias: 

 

 Manualmente 

 Añadiendo directamente documentos desde archivos PDF 

 Importando desde otros gestores bibliográficos como  EndNote, 

BibText y otras bibliotecas con formato RIS. 

 Importando resultados desde Bases de datos. Ejemplos: 

Mergullador, Embase, Web of Science,…  

 Importando desde otros sitios Web 

 SINCRONIZAR. (Synchronize Library) 

o Sincronizando desde cuentas de CiteUlike y Zotero 

 Añadiendo referencias desde cuentas de otros usuarios de 

Mendeley 

 

4.1. Manualmente 

 

Desde el menú principal pulsamos en “File” y elegimos “Add entry 

manually” para añadir la entrada manualmente. 

 

 (esta opción está también 

disponible desde la barra 

de herramientas en el 

desplegable “Add 

Documents”).  

 

 

 

 

Nos aparecerá un 

formulario para que 

introduzcamos los 
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datos del nuevo documento, indicando en primer lugar el tipo: 

artículo de revista (journal article), tesis (thesis), capítulo de libro 

(book section),…  Mendeley dispone de 20 tipos de documentos 

distintos, en función del tipo de documento elegido los campos a 

rellenar serán distintos. Además nosotros podemos personalizar y 

añadir otros campos a cada tipo de documento desde “Tools 

>options>document details 

Al introducir los datos bibliográficos del documento debemos tener en 

cuenta: 

 Autor: la entrada de los autores se hace en la forma Apellidos, 

Nombre 

 Se pueden añadir etiquetas (tags) que identifiquen el contenido 

del documento para su posterior recuperación. Se introducirán 

separadas por punto y coma. 

 Podemos incorporar un pequeño resumen, palabras clave, la 

URL donde se localice el artículo en Internet, un archivo con el 

texto completo del documento y también identificadores 

particulares del artículo como son el DOI o el PMID. 

 

4.2. Añadiendo directamente documentos desde 

archivos PDF 

 

Otra opción para incorporar información a nuestra biblioteca es 

añadiendo los archivos PDFs de los artículos. Mendeley recupera 

automáticamente los metadatos del documento, las palabras clave y 

las referencias citadas en ellos.  

Esto se puede hacer pinchando en el botón “Add Document” en la 

barra de herramientas  o arrastrando y soltando los PDFs en el panel 

de contenido. 
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Usando la opción “Add Document” podemos:  

4.2.1. Agregar un archivo individual pulsando en “Add 

File”, se abrirá un cuadro de diálogo para que escojamos el 

documento que queremos subir desde nuestro ordenador, o 

desde un disco de almacenamiento externo. 

4.2.2. Añadir una carpeta completa con “Add Folder”, 

desde un cuadro de diálogo similar al anterior podemos 

seleccionar la carpeta que contenga todos los Pdfs a 

incorporar, nos da la posibilidad de adjuntar también los 

documentos contenidos en las subcarpetas.  
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4.2.3. Usar la opción “Watch a folder” para incorporar 

PDFs automáticamente desde varias carpetas a la vez, 

revisará las carpetas y añadirá aquellos documentos de 

nueva incorporación.   
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Aquellos documentos de los que no se incluyesen todos los datos 

bibliográficos se añaden a la carpeta “Needs Review” para realizar 

una verificación manual y completarlos.  

Cuando se incorpora un documento, Mendeley revisa su catálogo Web 

para completar todos los datos bibliográficos del documento, además 

ofrece la posibilidad de buscar las referencias en Google Scholar, 

CrossRef, PubMed y ArXiv. 
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4.3. Importando desde otros gestores bibliográficos 

como  EndNote, BibText y otras bibliotecas con formato 

RIS. 

 

4.3.1. Desde EndNote. Como EndNote usa su propia 

extensión (.enl) para migrar a Mendeley, es necesario que 

exportemos la biblioteca de EndNote como un fichero .xml. 

Procediendo de la siguiente manera: 

i. En EndNote: Exportamos la biblioteca escogiendo 

.xml como tipo de fichero (type) y RIS como estilo 

de salida (output style), le damos un nombre y lo 

guardamos. 

ii. En Mendeley: Seleccionamos “Add Files”, 

seleccionamos el fichero XML que habíamos 

exportado previamente de EndNote y pulsamos en 

“Open”, Se incorporará la biblioteca de EndNote a 

Mendeley. 

4.3.2. Desde Mendeley usaremos la opción “Add Files” 

para importar referencias de BibText y RIS. 
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4.4. Importando resultados desde Bases de datos. 

Ejemplos: Mergullador, Embase, Web of Science,… 

 

Podemos añadir las referencias procedentes de una búsqueda 

bibliográfica que hayamos hecho en otras bases de datos, 

metabuscadores o catálogos de biblioteca y cuyos resultados 

tengamos guardados en el fichero correspondiente. Mostraremos el 

proceso a través de los siguientes ejemplos: 

4.4.1. Añadir referencias desde Mergullador (gestor de 

recursos electrónicos y metabuscador de Bibliosaúde. 

Biblioteca Virtual del Sistema Sanitario Público de Galicia). 

Previamente habremos realizado la búsqueda en 

Mergullador y guardado los resultados en “Mi espacio”.   

 

 

Desde “Mi espacio” marcamos los registros que nos interese 

importar pinchando en registros seleccionados y clicando en 

guardar. Aparecerá un recuadro que nos permitirá elegir el 

formato del fichero elegiremos GESTOR DE CITAS y lo 

codificaremos como UTF-8. 
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Lo añadiremos a Mendeley procedemos desde Add 

Documents> Add Files  

 

4.4.2. Desde una Base de datos: 

Realizaremos la búsqueda en EMBASE a través de la 
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plataforma OvidSP. Realizamos la búsqueda en EMBASE de la 

manera habitual y seleccionamos las referencias que nos 

interesa añadir a Mendeley, una vez seleccionadas pinchamos 

en “Exportar”, se abrirá un cuadro de diálogo en el que 

podemos elegir el formato de exportación. Elegiremos RIS y 

guardamos el fichero. Desde Mendeley lo importaremos 

utilizando la opción Add Documents> Add Files  

 

4.5. Importando desde otros sitios Web 

 

Mendeley permite la importación directa de referencias desde los 

siguientes sitios web: 

 

 ACM Portal  ACS 

Publications 

 AIP Scitation 

 Amazon  APS  APA PsycNET 

 arXiv  BioMedCentral  BioOne 

 CiNii  CiteseerX  CiteULike 

 Copac  DBLP  EBSCO 

 GBV  Google 

BookSearch 

 Google Scholar 

 IACR ePrints  IEEE Xplore  Informaworld 

 IngentaConnec
t 

 INIST / CNRS  Institute of Physics 

 ISI Web of 

Knowledge 

 JSTOR  Lancet Journals 

 MyOpenArchiv

e 

 NASA ADS  Nature 

 OpticsInfoBase  OvidSP  PLoS 

 PNAS  PubMed  Refdoc 

 RePEc  SAGE  ScienceDirect 

 ScienceMag 

http://portal.acm.org/portal.cfm
http://pubs.acs.org/
http://pubs.acs.org/
http://scitation.aip.org/
http://www.amazon.co.uk/
http://prola.aps.org/
http://psycnet.apa.org/
http://arxiv.org/
http://www.biomedcentral.com/
http://www.bioone.org/
http://ci.nii.ac.jp/
http://citeseerx.ist.psu.edu/
http://www.citeulike.org/
http://copac.ac.uk/
http://www.informatik.uni-trier.de/~ley/db/
http://search.ebscohost.com/
http://gso.gbv.de/xslt/
http://books.google.com/
http://books.google.com/
http://scholar.google.com/
http://eprint.iacr.org/
http://ieeexplore.ieee.org/Xplore/guesthome.jsp
http://www.informaworld.com/
http://www.ingentaconnect.com/
http://www.ingentaconnect.com/
http://cat.inist.fr/
http://www.iop.org/EJ/
http://www.isiknowledge.com/
http://www.isiknowledge.com/
http://www.jstor.org/
http://www.thelancet.com/
http://www.myopenarchive.org/
http://www.myopenarchive.org/
http://cdsads.u-strasbg.fr/
http://www.nature.com/
http://www.opticsinfobase.org/
http://ovidsp.ovid.com/
http://www.plos.org/
http://www.pnas.org/
http://www.ncbi.nlm.nih.gov/pubmed/
http://www.refdoc.fr/
http://ideas.repec.org/
http://www.sagepub.com/home.nav
http://www.sciencedirect.com/
http://www.sciencemag.org/
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Tenemos que utilizar la función “Web Importer”, que debemos 

instalar previamente. Desde el menú principal pinchamos en Tools  

Install Web Importer… 

 

 

 

 

Se abrirá la página de Internet desde dónde podemos arrastrar el 

botón de IMPORT TO MENDELEY  a la barra de herramientas de 

nuestro navegador. 

 

Para que funcione es necesario tener desactivada la opción “bloquear 

ventanas emergentes” del navegador. 
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Para ver un ejemplo del funcionamiento de esta herramienta, 

realizamos una búsqueda en Pubmed, una vez obtenidos los 

resultados pulsamos “Import to Mendeley” en la barra de 

herramientas del navegador. Nos pedirá nuestros datos de la cuenta 

de Mendeley  
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Y se abrirá una ventana para que añadamos las referencias a 

Mendeley. Podemos añadir etiquetas (tags) y notas a cada referencia 

que vayamos incorporando. Sólo se añaden las referencias que se 

muestran en pantalla en PubMed (por defecto 20). 

 

Las referencias se añadirán a nuestra cuenta Web de Mendeley, para 

incorporarlas a la versión local instalada en nuestro ordenador 

debemos utilizar la herramienta Sincronización (Synchronize Library). 

 

4.6. SINCRONIZAR. (Synchronize Library) 

 

Esta característica nos permitirá acceder a nuestros PDFs desde 

cualquier parte, el proceso a seguir es el siguiente: 

1. Seleccionamos “All Documents” en el panel My Library 

2. Seleccionar “Edit Settings” y seleccionamos las colecciones 

que queremos sincronizar 

3. Pulsar en “Sync Library” para sincronizar las cuentas de la 

versión local y web 
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4. Si no está abierta nos pedirá que introduzcamos las claves de 

nuestra cuenta web. 

 

El proceso de sincronización puede ser de web a local y de local a 

web, de forma que podemos enviar los pdfs guardados en el 

ordenador a nuestra cuenta web de Mendeley. Permite almacenar 

hasta 500MB. 

 

4.7. Sincronizando desde cuentas de CiteUlike y Zotero 

 

Si disponemos de bibliotecas de referencias en los gestores CiteUlike 

o Zotero podemos añadirlos a Mendeley sincronizando ambas 

cuentas. 

Desde Mendeley Desktop seleccionamos Tools  Options 
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Se abrirá un cuadro de diálogo desde dónde podremos elegir el 

gestor que queremos sincronizar: CiteUlike o Zotero 

 

 

CiteUlike. Es posible sincronizar la cuenta web de CiteUlike con la de 

Mendeley, de forma que los documentos incorporados a la cuenta de 

CiteUlike serán importados a Mendeley automáticamente, siguiendo 

los siguientes pasos: 
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En el apartado de configuración de la cuenta de Mendeley, 

seleccionamos la opción “Sharing/Importing” 

 

e introducimos nuestro nombre de usuario de la cuenta de CiteUlike 

(CiteUlike username) 

 

 

Nos llevará a un mensaje de activación en la página de CiteUlike, que 

debemos activar 

 

 

 

Una vez confirmada nos llevará a la página de configuración de 

nuestro perfil en CiteUlike donde hemos de activar la casilla “Enable 

Mendeley”, una vez hecho esto deberemos actualizar el perfil, 

pulsando en “Update profile” 
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Esta sincronización se desactivará si no entramos en la cuenta de 

Mendeley al menos una vez cada 30 días, aunque siempre se podrá 

volver a sincronizar, volviendo a activar la casilla “Enable Mendeley”. 

 

Zotero. Para importar documentos directamente desde Zotero es 

necesario que la instalación local de Mendeley esté en el mismo 

ordenador que la de Zotero. 

Desde la pestaña Zotero / CiteUlike de la opción Tools > Options, 

sólo tendremos que activar la casilla de integración con Zotero 

(“Zotero integration”) y pulsar aceptar. 
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Mendeley automáticamente localizará la base de datos de Zotero, 

también se puede elegir una base de datos alternativa si se desea. 

Una vez que se apliquen los cambios, pulsando en “Apply”, todos los 

documentos de Zotero serán importados a Mendeley y cualquier otro 

que se añada en el futuro a Zotero se incorporará también 

automáticamente. 

 

 

4.8. Añadiendo referencias desde cuentas de otros 

usuarios de Mendeley 

 

Es posible añadir referencias desde cuentas de otros usuarios de 

Mendeley, para ello primero haremos una búsqueda en la web de 

Mendeley sobre el tema de nuestro interés: 

 

Y del listado de resultados obtenidos añadimos a nuestra biblioteca 

aquellos que nos interesen, pinchando en “save references to 

library” 
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5. EXPORTAR REFERENCIAS 

 

Es posible crear un fichero de exportación de referencias de nuestra 

biblioteca Mendeley para poder importarlas a otros gestores 

bibliográficos como EndNote, BibText,… Para ello: 

 Seleccionaremos los documentos que queremos exportar y 

pinchamos File  Export o presionando Ctrl + E ( o Cmd + E 

en Mac) 

 

 Se abrirá un cuadro de diálogo en el que podremos elegir el 

formato en el que queremos guardar el fichero: .xml, .ris o 

BibTex 
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6. TRABAJAR CON DOCUMENTOS Y REFERENCIAS 

6.1. Leídos/no Leídos y favoritos 

 No leídas. Cuando se añaden a Mendeley las referencias 

aparecen marcadas como no leídas con un círculo verde. 

Una vez que se abren el círculo verde desaparece y 

quedan marcadas como leídas. Podemos marcarlas y 

desmarcarlas como no leídas tantas veces como 

deseemos. 

 

 Favoritos. Las referencias y documentos favoritos se marcan 

con el icono de una estrella a la izquierda de la referencia. 

Se marcan simplemente clicando sobre la estrella para 

marcarlos como favoritos o repitiendo el clic para 

desmarcarlos. 

Además todos los marcados como favoritos aparecen en la carpeta 

“Favorites” del panel My Library. 
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6.2. Ordenar las referencias. 

Es posible ordenar las referencias desde el panel de contenido, 

para ello simplemente hemos de pinchar sobre la columna que 

indica el criterio por el que queremos ordenar: favoritos, leído/no 

leído, documentos con pdf adjunto, autor, título, año, revista y 

fecha de incorporación a la base de datos 

 

 

6.3. Depurar nombres de autor, etiquetas o 

publicaciones duplicadas. 

En el panel de filtro por autor/etiquetas y publicaciones, (Filter by 

authors/tags/publications) seleccionamos el nombre que sepamos 

que está duplicado o es incorrecto, y pulsar y arrastra sobre la forma 

correcta para renombrarlo. 

Por ejemplo si tenemos dos documentos etiquetados como “web2.0” 

y “We_2_0” podemos arrastrar éste último sobre la forma correcta. 
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6.4. Etiquetar y editar varios documentos a la vez. 

 

Para añadir etiquetas o detalles a más de un documento a la vez, 

debemos: 

 Seleccionar los documentos que queremos editar a la vez, 

pulsando la tecla Ctrl a la vez que hacemos clic en los 

documentos que queremos seleccionar 

 En el panel de detalles del documento aparecerá un mensaje 

de confirmación 

 Añadiremos los datos que queremos incorporar a todos los 

documentos 

Los datos pueden ser etiquetas, notas u otros detalles bibliográficos 

como el nombre de la revista o publicación. 

 

 

 

6.5. Buscar 

 

En la versión local, Mendeley contiene un buscador que permite 

buscar aquellos documentos que contengan un determinado término, 

éste aparecerá destacado tanto en las referencias como en todos los 

documentos que lo contengan.  
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Puede buscar en los campos de autor, título, nombre de la 

publicación, año y notas.  También se puede realizar la búsqueda 

dentro del pdf con el texto completo del documento. 

 

 

 

6.6. Realizar anotaciones en los PDFs 

Mendeley dispone de un visor de PDFs, en la versión local, que 

permite añadir subrayados y anotaciones a los documentos. Para 

ello: 

1. Abrimos un PDF en el visor de Mendeley haciendo doble clic en 

el panel central 
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2. Añadiremos subrayados haciendo clic en “Highlight Text” o 

añadiremos notas pulsando el botón “Add Note” del menú de la 

barra de herramientas 

 

 

Estas anotaciones se pueden compartir con nuestros 

colaboradores, para hacerlo 

1. Debemos abrir un PDF que pertenezca a un grupo (veremos 

cómo hacer grupos y compartir documentos más adelante) 

2. Hacer las anotaciones 

3. Sincronizar esas anotaciones con Mendeley Web desde “My 

Library” >”Sync Library”. 

Nota: estas anotaciones no están guardadas en el fichero PDF actual, 

sino en la cuenta de Mendeley. Para crear un nuevo PDF que 

contenga todas las anotaciones, tendremos que exportar este PDF 

con las anotaciones de la siguiente forma: desde FileExport with 

Annotations desde el visor de PDFs de Mendeley. 
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7. ELIMINAR DUPLICADOS 

 

Cuando añadimos información a Mendeley desde diferentes fuentes, 

puede darse el caso de que las referencias importadas estén 

duplicadas. Eliminar los duplicados manualmente si tenemos un 

cantidad importante de referencias y documentos puede resultar muy 

molesto. Mendeley nos ayuda a elimnarlos desde la herramienta 

disponible en el menú principial Tools > Check for Duplicates. 
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Con esto, el programa revisa automáticamente la carpeta que hemos 

seleccionado para detectar los duplicados, puede ser una carpeta en 

concreto o todos los documentos de nuestra biblioteca si 

seleccionamos “All Documents”.  

Los documentos identificados como posibles duplicados se agrupan en 

la vista principal del panel de contenidos.   

 

 

 

Se puede usar la flecha a la izquierda de las referencias para ver 
todos los documentos de un grupo. Se mostrará la columna 

“confidence” , lo que indica el grado de acierto de Mendeley al 
seleccionar los duplicados. 

Para seleccionar los duplicados:  

1. Seleccionar la carpeta o grupo en los que queremos buscar 

duplicados 
2. Seleccionar “Tools” en el menú principal y seleccionar  la opción 

“Check for Duplicates” 
3. Se mostrarán los grupos de duplicados  

4. Sólo se unirán todas las referencias en una cuando se lo 
confirmemos. Haciendo doble clic se puede ver cada referencia 

duplicada individualmente. 
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7.1. Unir duplicados 

1. Seleccionar un grupo y revisar los metadatos en el panel de la 
derecha. Cuando a la izquierda de cada campo aparece una 

marca (tick)  a la izquierda, esto quiere decir que contiene la 
misma infromación en todas las referenicas, de forma que 

podemos pinchar en  el botón “ Confirm Merge” para unir 

todas las referencias del grupo en una.   
2. Si un campo no está marcado, significa que 2 o más referencias 

duplicadas del grupo no tiene los mismos datos, de modo que 
debemos comprobar que efectivamente estén duplicados.  

3. Si cualquiera de los campos no marcados es incorrecto, se 
pueden editar los datos y corregirlos. 

4. Por otra parte, is sabemos que uno de los duplicados tenían los 
metadatos correctos, pero Mendeley ha recogido los datos 

erróneos, se puede ampliar el conjunto con un doble clic (o clic 
en la flecha a la izquierda), seleccionar el documento correcto y 

marcar la casilla que aparece junto a los metadatos que se 
desea utilizar. De esta forma, se puede escoger y elegir los 

datos por separado desde cualquier documento del grupo, pero 
cuando se marque un campo aquí, se sobrepone a lo que se ha 

seleccionado como datos correctos para unir, 
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7.2. Duplicados incorrectos 

Si se descubren 2 documentos que están en un grupo de duplicados 

pero que no lo son, simplemente, expande el grupo, se selecciona el 
documento marcado erróneamente como duplicado y se hace clic en 

el botón “Not a Duplicate”. (Esto a menudo es necesario cuando hay 
muchos registros sin título). 
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Nota: La decisión “Not a Duplicate” es temporal, si se vuelve a 

ejecutar la herramienta “Check for Duplicates” otra vez, estos 
documentos volverán a mostrarse como duplicados. 

 

7.3. Unión manual de duplicados 

Si se observa que hay duplicados que, por alguna razón, Mendeley no 

encuentra, se pueden unir los documentos manualmente. 
Simplemente seleccionando 2 o más documentos mientras se 

mantiene pulsada la tecla Control y aparecerá el botón “Merge 
Documents” en el panel derecho. Se pincha y se siguen los pasos 

normalmente. 

 

7.4. ¿Qué pasa si nos equivocamos? 

Cualquier unión que hagamos con la herramienta de buscar 
duplicados se puede deshacer usando la opción Edit>Undo, del 

menú principal. Si nos damos cuenta tarde, aún podemos deshacer el 
error. Cuando se unen duplicados, todos los documentos van a la 

carpeta Trash, y se crea un nuevo documento, así que si no se ha 
limpiado la carpeta Trash se pueden restaurar los documentos 

originales desde ahí e intentar unirlos de nuevo. 
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8. ORGANIZAR FICHEROS 

 

El organizador de ficheros de Mendeley permite renombrar 

automáticamente nuestros PDFs y archivarlos en una estructura 

clara de carpetas que permita encontrar fácilmente los ficheros 

desde fuera de Mendeley (por ejemplo desde el explorador de 

Windows) 

Lo encontraremos en: 

ToolsOptions FileOrganizer tab (Windows) 

Mendeley PreferencesFile organizer tab (Mac) 

 

 

En la pestaña “File Organizer” hemos de seleccionar: 

1. “Organize my files”: permite hacer una copia de todos los 

documentos añadidos a Mendeley en una carpeta  

2. “Sort files into subfolders”: permite crear una estructura de 

carpetas basada en detalles de los documentos seleccionados 

3. “Rename document files”: para renombrar de forma que incluya 

autor, revista, año y título 
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9. CITAR REFERENCIAS Y FORMATEAR EL 

MANUSCRITO 

 

El proceso de citación y formateado de bibliografía es un proceso 

laborioso especialmente si se hace manualmente. Mendeley 

genera bibliografías y listas de referencias en 1.000 estilos de 

citación distintos. Es compatible con los principales editores de 

texto entre ellos: Word, OpenOffice, Google Docs y LaTex. 

 

9.1. Estilos de cita bibliográfica 

 

Para seleccionar el estilo de cita que queremos, desde la 

instalación local de Mendeley debemos: 

a. Pulsar View>Citation Style del menú principal 

b. Seleccionar el estilo que necesitamos usar. Por defecto 

Mendeley nos ofrece los estilos más comunes 
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c. En caso de que el estilo no esté en el listado debemos 

hacer clic en “More Styles” y buscar el que 

necesitemos e instalarlo de forma que quedará 

incorporado a nuestra lista  

 

 

 

9.2. Generar Bibliografías,  insertar citas y formatear un 

manuscrito 

 

Para generar bibliografías, insertar y dar formato a un manuscrito con 

citas de Mendeley, debemos tener instalados los plug-ins disponibles 

para Word y OpenOffice. Para realizar esta instalación debemos 

seguir los siguientes pasos: 

 Desde la opción “Tools” del menú principal debemos 

seleccionar la instalación que necesitemos: Install MS 

Word Pluging o Install OpenOffice 
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 Una vez realizada la instalación se incorporará a la 

barra de herramientas de Word en la opción 

“Complementos” (Microsoft Word Office 2007) 

 

 

 

Ya podemos trabajar con un manuscrito en Word 

o Pinchamos en “Insert Citation” en la barra de 

herramientas de Mendeley en Word.  

(Word>Complementos>Insert Citation) 

o Desde Mendeley Desktop seleccionamos el documento 

y pinchamos “Send Citation to Word”, podemos 

citar varios documentos si a la vez que los 

seleccionamos mantenemos pulsada la tecla Ctrl (o 

Cmd en Mac). 

o Seleccionaremos el estilo de cita que deseemos utilizar 

en Word en el desplegable “citation style” 

(Word>complementos>citation style). Cada vez que 

elijamos un estilo diferente deberemos hacer clic en 

“Refresh” para “refrescar” y aplicar los cambios de 

estilo. 

o Para finalizar generaremos la bibliografía pinchando “ 

Insert Bibliography”  

o Mendeley nos ofrece la posibilidad de exportar el 

documento,  desde el botón “Export” podremos 
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guardar una versión del documento compatible con 

OpenOffice o una versión sin los campos de Mendeley. 

 

 

Citar documentos en Google docs (y otros editores de texto) 

Se pueden añadir citas a otros editores de texto como 

Google Docs, simplemente seleccionando en Mendeley 

Desktop el documento que queremos citar y haciendo clic 

en: Edit  Copy citation 

 

Después lo pegamos en el documento en el que estamos 

trabajando, también se puede arrastrar y soltar desde 

Mendeley a la ventana donde estemos trabajando con el 

documento. 
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10. COMPARTIR DOCUMENTOS Y REFERENCIAS  

 

9.3. GRUPOS 

 

Los grupos son “una forma sencilla de colaborar con colegas 

mediante la creación de una colección de documentos 

compartidos.(1)(3)” Cualquier usuario de Mendeley puede crear un 

grupo con colaboradores o con investigadores desconocidos. 

Cualquier miembro del grupo puede subir documentos al mismo. 

Para crear un grupo hacer clic en “Create Group” en el panel 

izquierdo o usando la opción Edit > New Group del menú principal.  
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Una vez creado el grupo nos pedirá que introduzcamos los detalles en 

el siguiente cuadro diálogo: 

 

 

 Group name: Especificaremos el nombre del grupo 

 Group description: donde podremos dar más detalles 

sobre el grupo con una breve descripción 
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 Privacy settings: esta sección nos permite establecer 

el tipo de grupo que vamos a crear 

 Give this group more details: Nos permite añadir 

etiquetas o indicar la disciplina en la que investigamos 

(si no especificamos nada se añadirá la disciplina que 

tengamos en nuestro perfil). 

 Debemos pinchar en Create Group para finalizar  

 Para borrar un grupo, lo seleccionamos y 

seleccionamos Edit> Remove group del menú 

principal 

Nota: siempre podremos cambiar estos criterios seleccionando el 

grupo que hemos creado y pinchando “Edit settings” 

 

 

 

Es posible crear 3 tipos de grupos diferentes: 

Grupos privados (private groups). Son grupos a los que se puede 

pertenecer sólo por invitación y cuyo contenido sólo será visible para 

los miembros del grupo. Son grupos para proyectos de investigación 

privados o para compartir documentos y anotaciones. 

Grupos públicos con invitación (Anyone can ask to join this 

group). Grupos visibles para cualquiera pero en los que sólo pueden 

contribuir los miembros del grupo. Interesantes para listas de lectura 

pública o conservar los resultados de investigación 

Grupos públicos abiertos (Anyone can join this group). Grupos 

a los que cualquiera puede unirse y contribuir a ellos. Diseñados para 

ser grupos de discusión abiertos en torno a un tema. 
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AÑADIR MIEMBROS Y DOCUMENTOS 

 

Una vez creado el grupo podemos añadir los miembros y 

documentos: 

1. Invitando a gente desde la pestaña “Members” 

2. Se pueden añadir investigadores que son ya contactos 

nuestros en Mendeley pinchando en “Add” y se puede 

invitar a gente por e-mail para unirse al grupo pinchando 

en “Invite” 

3. Para ver los documentos de un grupo debemos ir a la 

pestaña “Documents”.  

4. Si lo que queremos es añadir documentos, seleccionamos 

el grupo y clicamos en “Add documents” en la barra de 

herramientas. También es posible usar la función 

“arrastrar y soltar” tanto para añadir documentos desde 

las carpetas de Mendeley como desde cualquier otro lugar 

de nuestro ordenador. 

5. Es posible descargar los PDFs que incorporaron al grupo 

otros miembros, desde “Edit Settings” y marcar 

“Download attached files from group” en “File 

synchronization”. Sólo se podrán compartir PDFs en 

grupos privados, no en los públicos. 

6.  Podremos subir a Mendeley Web  todos las 

características que hayamos  dado a los grupos, 

sincronizando la biblioteca desde el botón “Sync Library”  

Dese la pestaña “Overview” tenemos acceso a un resumen de lo que 

pasa en el grupo: quién se une, quién hace comentarios, y que 

documentos han sido añadidos y por quién. 
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También permite hacer comentarios para compartir con los miembros 

del grupo desde la caja de texto que encabeza la sección. Y escribir 

comentar las entradas de otros o comenzar un debate sobre un tema. 

 

 

Asímismo, podemos ver el grupo en la versión Web de Mendeley y 

“copiar” el código fuente del grupo para añadirlo “incrustado” a 

nuestra página web o blog, desde el enlace embbed. (esta opción 

no está disponible en los grupos privados) 
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11. VERSIÓN WEB 

 

 

Una vez ingresamos en Mendeley Web, aparecerá una página que nos 

permitirá: 

1. Añadir y actualizar información sobre nuestro perfil: detalles 

personales, curriculum vitae, privacidad, intereses 

profesionales, etc. Desde la pestaña “My Account” 

2. Conocer las actualizaciones de nuestros contactos, crear y 

gestionar la biblioteca de referencias,  buscar documentos, 

crear grupos y buscar contactos a través de las pestañas: 

“Dashboard”, ” My Library”, ”Papers”,  “Groups” y 

“People”  

3. Conocer otros usuarios con intereses similares y estadísticas 

sobre los autores más leídos.  
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Desde la pestaña “My Library” tendremos acceso a las referencias 

bibliográficas que hayamos incluido en nuestra cuenta, bien 

directamente desde la Web o sincronizando con Mendeley Desktop. 

La pantalla se estructura de la siguiente manera 

1.- Barra de herramientas, desde dónde podremos: 

5. Añadir documentos. Pinchando en “Add Document” podremos 

añadir la referencia bibliográfica manualmente 

6. Borrar documentos y referencias de nuestra biblioteca pinchando 

en “Delete documents” 

7. Retirar las referencias y documentos seleccionados de una 

carpeta, desde “Remove from folder” 

8. Crear carpetas para organizar las referencias con la opción “Create 

Folder” y borrar carpetas desde “Remove Folder” 

9. Ir a la sección de Grupos directamente para crear un grupo, 

usando “Create Group” 

10. Instalar el botón “Web Importer” en nuestro navegador para 

importar referencias directamente desde los sitios compatibles. 
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11. Ver el estado de nuestra cuenta pinchando en “Account Usage” 

2.- Referencias bibliográficas contenidas en nuestra biblioteca.  

3.- Gestión de carpetas y Grupos. En función de la carpeta o grupo 

que seleccionemos se presentarán las referencias bibliográficas que 

hayamos incluido en ese grupo o carpeta. 

4.- Filtro de publicaciones, autores, etiquetas y palabras clave. Usar 

este filtro nos permite seleccionar todas las referencias y documentos 

de un autor, de una publicación o las que hayamos clasificado bajo 

una determinada etiqueta. 

5.- Etiquetas (tags) usadas en la Biblioteca. Lista todas las tags que 

hayamos usado para clasificar las referencias bibliográficas, tanto en 

nuestra biblioteca como las etiquetas de los grupos a los que 

pertenezcamos. 

La pestaña “Papers” nos ofrece la posibilidad de navegar por las 

distintas disciplinas en que se organiza Mendeley “hojeando” las 

referencias y documentos incluidos en cada una o realizar búsquedas 

en todo el catálogo de Mendeley. En este caso podremos utilizar la 

búsqueda simple o el buscador avanzado “Advanced Search” que 

ofrece distintas combinaciones de búsqueda por campos. 
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Desde la pestaña “Groups” podremos crear y acceder a la 

información de los grupos a los que pertenezcamos. También 

podremos navegar y buscar grupos en Mendeley, ver las referencias 

contenidas en cada grupo y los miembros que lo forman. Podremos 

unirnos a un grupo “join group” o hacer un seguimiento del mismo 

“Follow group”. 

Por último desde la pestaña “People” podemos buscar contactos e 

invitar a colegas a unirse a nuestra red de Mendeley.  
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13. ANEXOS: VIDEOS Y PRESENTACIONES 
 

Están disponibles los siguientes video tutoriales en el canal de 

Youtube: 

 

1. Crear una cuenta e instalar Mendeley. 

http://www.youtube.com/watch?v=srtiraE_hco&context=C4d49d7

8ADvjVQa1PpcFNuNwhZvHzMlq8N195Wk1HAGQsPaIGgI40=  

2. Añadir referencias manualmente. 

http://www.youtube.com/watch?v=Dg_1u5KchA4&context=C4883

c01ADvjVQa1PpcFNuNwhZvHzMljrOoM5gD0t_mtfL1vN-ldw=  

3. Añadir referencias desde PDFs. 

http://www.youtube.com/watch?v=7zdiHAnDPOE&context=C4d4a

bdcADvjVQa1PpcFNuNwhZvHzMlsMvue0FmRKWzsVTDOYS7Nw= 

4. Añadir referencias desde sitios web I. 

http://www.youtube.com/watch?v=sG77U1xhBKk&context=C4122

7c9ADvjVQa1PpcFNuNwhZvHzMlv0hSWjBYCKZ8_4aAOvtvps= 

5. Añadir referencias desde sitios web II. 

http://www.youtube.com/watch?v=lBjF4SaPsU0&context=C425be

0aADvjVQa1PpcFNuNwhZvHzMlo3FLAP_8crd3S47wVQDvMQ= 

http://www.youtube.com/watch?v=srtiraE_hco&context=C4d49d78ADvjVQa1PpcFNuNwhZvHzMlq8N195Wk1HAGQsPaIGgI40=%20
http://www.youtube.com/watch?v=srtiraE_hco&context=C4d49d78ADvjVQa1PpcFNuNwhZvHzMlq8N195Wk1HAGQsPaIGgI40=%20
http://www.youtube.com/watch?v=Dg_1u5KchA4&context=C4883c01ADvjVQa1PpcFNuNwhZvHzMljrOoM5gD0t_mtfL1vN-ldw
http://www.youtube.com/watch?v=Dg_1u5KchA4&context=C4883c01ADvjVQa1PpcFNuNwhZvHzMljrOoM5gD0t_mtfL1vN-ldw
http://www.youtube.com/watch?v=7zdiHAnDPOE&context=C4d4abdcADvjVQa1PpcFNuNwhZvHzMlsMvue0FmRKWzsVTDOYS7Nw
http://www.youtube.com/watch?v=7zdiHAnDPOE&context=C4d4abdcADvjVQa1PpcFNuNwhZvHzMlsMvue0FmRKWzsVTDOYS7Nw
http://www.youtube.com/watch?v=sG77U1xhBKk&context=C41227c9ADvjVQa1PpcFNuNwhZvHzMlv0hSWjBYCKZ8_4aAOvtvps
http://www.youtube.com/watch?v=sG77U1xhBKk&context=C41227c9ADvjVQa1PpcFNuNwhZvHzMlv0hSWjBYCKZ8_4aAOvtvps
http://www.youtube.com/watch?v=lBjF4SaPsU0&context=C425be0aADvjVQa1PpcFNuNwhZvHzMlo3FLAP_8crd3S47wVQDvMQ
http://www.youtube.com/watch?v=lBjF4SaPsU0&context=C425be0aADvjVQa1PpcFNuNwhZvHzMlo3FLAP_8crd3S47wVQDvMQ
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6. Exportar referencias. 

http://www.youtube.com/watch?v=8XGHMQDLw2Q&context=C4b

cc294ADvjVQa1PpcFNuNwhZvHzMlo8z7a_Y9YPS139RdRE20ZI= 

7. Trabajar con referencias. 

http://www.youtube.com/watch?v=99cPEabRPwM&context=C40b9

5a5ADvjVQa1PpcFNuNwhZvHzMlhWTio3qkoT8gLOeP6h0PTM= 

8. Marcar y ordenar referencias y documentos. 

http://www.youtube.com/watch?v=RWf3RnCuNsQ&context=C40a

a0eaADvjVQa1PpcFNuNwhZvHzMluq_uC62gJ4F4JEz8uSTxsA= 

9. Trabajar con referencias: Buscar y realizar anotaciones. 

http://www.youtube.com/watch?v=5vL3iUBYpL4&context=C46dfb

32ADvjVQa1PpcFNuNwhZvHzMltjjE9zEOD-MeblzuHGHdBA= 

10. Estilos de cita bibliográfica. 

http://www.youtube.com/watch?v=grb2urDa0qc&context=C45e43

80ADvjVQa1PpcFNuNwhZvHzMlkjFllz3uPZufpC3pour55Q= 

11. Insertar citas y formatear el manuscrito. 

http://www.youtube.com/watch?v=qOrSAPXcJiw&context=C4bbce

e1ADvjVQa1PpcFNuNwhZvHzMlkL10k7ji9_wPOM4L5RGS3s= 

12. Compartir referencias y manuscritos. 

http://www.youtube.com/watch?v=W44DCa4ku9U&context=C431

2b0aADvjVQa1PpcFNuNwhZvHzMllLIU70nFjYbny3KGV_WIXM= 

13. Eliminar documentos. 

http://www.youtube.com/watch?v=vkgWuHTSApo&context=C428

607aADvjVQa1PpcFNuNwhZvHzMloN8-2TK457IDCQGB-3UvYs= 

 

 

http://www.youtube.com/watch?v=8XGHMQDLw2Q&context=C4bcc294ADvjVQa1PpcFNuNwhZvHzMlo8z7a_Y9YPS139RdRE20ZI
http://www.youtube.com/watch?v=8XGHMQDLw2Q&context=C4bcc294ADvjVQa1PpcFNuNwhZvHzMlo8z7a_Y9YPS139RdRE20ZI
http://www.youtube.com/watch?v=99cPEabRPwM&context=C40b95a5ADvjVQa1PpcFNuNwhZvHzMlhWTio3qkoT8gLOeP6h0PTM
http://www.youtube.com/watch?v=99cPEabRPwM&context=C40b95a5ADvjVQa1PpcFNuNwhZvHzMlhWTio3qkoT8gLOeP6h0PTM
http://www.youtube.com/watch?v=RWf3RnCuNsQ&context=C40aa0eaADvjVQa1PpcFNuNwhZvHzMluq_uC62gJ4F4JEz8uSTxsA
http://www.youtube.com/watch?v=RWf3RnCuNsQ&context=C40aa0eaADvjVQa1PpcFNuNwhZvHzMluq_uC62gJ4F4JEz8uSTxsA
http://www.youtube.com/watch?v=5vL3iUBYpL4&context=C46dfb32ADvjVQa1PpcFNuNwhZvHzMltjjE9zEOD-MeblzuHGHdBA
http://www.youtube.com/watch?v=5vL3iUBYpL4&context=C46dfb32ADvjVQa1PpcFNuNwhZvHzMltjjE9zEOD-MeblzuHGHdBA
http://www.youtube.com/watch?v=grb2urDa0qc&context=C45e4380ADvjVQa1PpcFNuNwhZvHzMlkjFllz3uPZufpC3pour55Q
http://www.youtube.com/watch?v=grb2urDa0qc&context=C45e4380ADvjVQa1PpcFNuNwhZvHzMlkjFllz3uPZufpC3pour55Q
http://www.youtube.com/watch?v=qOrSAPXcJiw&context=C4bbcee1ADvjVQa1PpcFNuNwhZvHzMlkL10k7ji9_wPOM4L5RGS3s
http://www.youtube.com/watch?v=qOrSAPXcJiw&context=C4bbcee1ADvjVQa1PpcFNuNwhZvHzMlkL10k7ji9_wPOM4L5RGS3s
http://www.youtube.com/watch?v=W44DCa4ku9U&context=C4312b0aADvjVQa1PpcFNuNwhZvHzMllLIU70nFjYbny3KGV_WIXM
http://www.youtube.com/watch?v=W44DCa4ku9U&context=C4312b0aADvjVQa1PpcFNuNwhZvHzMllLIU70nFjYbny3KGV_WIXM
http://www.youtube.com/watch?v=vkgWuHTSApo&context=C428607aADvjVQa1PpcFNuNwhZvHzMloN8-2TK457IDCQGB-3UvYs
http://www.youtube.com/watch?v=vkgWuHTSApo&context=C428607aADvjVQa1PpcFNuNwhZvHzMloN8-2TK457IDCQGB-3UvYs

